Click here for production status of specific part numbers.

MAX20340 Evaluation Kit

General Description

The MAX20340 evaluation kit (EV kit) is a fully assembled
and tested PCB that evaluates the MAX20340 bidi-
rectional powerline communication (PLC) management
integrated circuit. The EV kit obtains power from the
MAX32625PICO microcontroller that contains the firm-
ware necessary to use the EV kit GUI program. The EV kit
features a master/slave mode PLC with flexible configura-
tions. The EV kit ships with jumpers installed and supply
voltages set to typical operating values.

Features

e USB-Powered Operation

e Compact and Simple Solution for PLC

e Flexible Configuration

e On-Board Regulator and Battery-Charging Circuitry

e Windows® 7/8/10-Compatible GUI Software

e Fully Assembled and Tested

Evaluation Kit Contents
e MAX20340 EV Kit

e Two USB A to micro-USB Cables

MAX20340 EV Kit Files

FILE DECRIPTION

MAX20340EVKit.exe PC GUI Program

Windows is a registered trademark and registered service mark
of Microsoft Corporation.

319-100481; Rev 0; 12/19

Evaluates: MAX20340

Quick Start

Required Equipment

Note: In the following sections, software-related items are
identified by bold text. Text in bold refers to items directly
from the install of EV kit software. Text that is bold and
underlined refers to items from the Windows operating
system.

e MAX20340 EV kit
e Two USB A to micro-USB cables
e Windows PC with USB ports

Procedure

The EV kit is fully assembled and tested. Use the fol-
lowing steps to verify board operation. Caution: Do not
turn on the power supply until all connections are
completed.

1) Visit https://www.maximintegrated.com to
download the latest version of the EV kit software,
MAX20340EVKitSetupV050.ZIP located on the
MAX20340 EV kit web page. Download the EV kit
software to a temporary folder and uncompress the
ZIP file.

2) Install the EV kit software on your computer by run-
ning the MAX20340EVKitSetupV050.EXE program
inside the temporary folder.

3) Verify that all jumpers are in their default positions,
as shown in Table 1.

4) Connect the micro-USB end of a cable to USB1 port
of the EV kit and the type-A end to the PC.

Ordering Information appears at end of data sheet.
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5) Connect the micro-USB end of a cable to the USB
port of the MA32625PICO microcontroller and the

type-A end to the PC.

6) The LED on the MA32625PICO microcontroller

flashes blue.

7) Start the MAX20340 EV kit GUI. The EV kit software
main window appears, as shown in Figure 1.

Evaluates: MAX20340

8) If connection is successfully established, the status
bar the bottom displays Connected.

9) Verify the status of the master: Slave Found Charg-
ing on the left Master panel and the status of the
slave: Master Found Comm. Enabled on the right
Slave panel.

10) The EV kit is now ready for additional evaluations.

(@ Bi-directional Power Line Communication (MAX20340) EV Kit Tool - [m] X
File Device Options Help
General Configure Communication Test | Register Map
Read All
Master Slave
Master *C Address 0xD4 Slave *C Address 0x2A
State Machine Status Slave Found, Charging State Machine Status Master Found, Comm. Enabled
Received Data 0 0x00 Received Data 0 0x00
Received Data 1 0x00 Received Data 1 0x00
Received Data 2 0x00 Received Data 2 0x00
Read Data Read Data
PLC Communication Period 24ps v PLC Communication Period 24pus A\
PLC Master RX Wait Timer 10ms v PLC Sink Current 298mA v
PLC Sink Current 298mA - Communication Detection Threshold 80mV -
Communication Detection Threshold 80mvV v Parity Odd A\
Parity Odd v
Number of Bytes to Transmit 3 - Echo Enable
Echo Off
Transmit Data 0 | 0x00 | @ Echo On
. Echo Complement
Transmit Data 1
Transmit Data 2 | 0x00 |
Transmit
Transmit Result Transmit OK, Echo Received Transmit Result Receive OK, Echo Sent
MAX20340 EVKit P2 (FW Ver. 0.5.1) | Connected .

Figure 1. The Status of the GUI Shows Connected Ready for Further Evaluations
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MAX20340 Evaluation Kit

Detailed Description of Software

Software Startup

Upon starting the program, the EV kit software automati-
cally searches for the USB interface circuit and then for
the IC device addresses. The EV kit enters the normal
operating mode when the connection is established and
addresses are found. If the USB connection is not detect-
ed, the status bar displays Not Connected. If the USB
connection is detected, but the MAX20340 is not found,
the Master or Slave panel in the General tab shows Not
Found.

ToolStrip Menu Bar
The ToolStrip menu bar (Figure 2) is located at the top
of the GUI window. This bar comprises File, Device,
Options, and Help menus whose functions are detailed
in the following sections.

File Menu

The File menu contains the option to exit out of the GUI
program.

Evaluates: MAX20340

Device Menu

The Device menu provides the ability to connect or dis-
connect the EV kit to the GUI. If a board is disconnected
while the GUI is open the GUI displays Disconnected in
the lower right corner. If the device is then plugged back
in, the bottom right corner of the GUI displays Connected.

Options Menu

The Options menu provides several settings to access
more features offered by the GUI. The Disable polling
option lets the user read the registers manually instead of
getting automatically frequent register updates from the
IC. MAX20343 option allows the user to reset, enable, or
disable the buck-boost regulator on the EV kit. Also, the
user can view the Serial Log of reading or writing regis-
ters in the Advanced option.

Help Menu

The Help menu contains the About option, which dis-
plays the GUI splash screen indicative of the GUI version
being used.

File Device Options Help

Bi-directional Power Line Communication (MAX20340) EV Kit Tool

Figure 2. The ToolStrip Menu Items
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MAX20340 Evaluation Kit

Tab Controls

The MAX20340 EV kit software GUI provides a conve-
nient way to test the features of the MAX20340. Each tab
contains controls relevant to various blocks of the device.
Changing these interactive controls triggers a write opera-
tion to the MAX20340 to update the register contents.

Evaluates: MAX20340

General Tab

The General tab (Figure 3) provides all important infor-
mation and options to set up the MAX20340 master and
slave modes. The Master block (on the left side) and
Slave block (on the right side) display 12C addresses and
allow the user to choose parameters for each setting in
powerline communication.

(@ Bi-directional Power Line Communication (MAX20340) EV Kit Tool

File Device Options Help

General | Configure | Communication Test Register Map

Master
Master [2C Address 0xD4
State Machine Status Slave Found, Charging
Received Data 0 0x00
Received Data 1 0x00
Received Data 2 0x00
Read Data
PLC Communication Period 24ps >
PLC Master RX Wait Timer 10ms v
PLC Sink Current 298mA i
Communication Detection Threshold 80mV v
Parity Odd v
Number of Bytes to Transmit 3 v
Transmit Data 0 | 00 |
Transmit Data 1
Transmit Data 2 | ox00 |
Transmit

Transmit Result Transmit OK, Echo Received

MAX20340 EVKit P2 (FW Ver. 0.5.1)

= [m] X
Read All
Slave ea
Slave 2C Address 0x2A
State Machine Status Master Found, Comm. Enabled
Received Data 0 0x00
Received Data 1 0x00
Received Data 2 0x00
Read Data

PLC Communication Period 24ps v
PLC Sink Current 298mA X
Communication Detection Threshold 80mv ¥
Parity Odd v

Echo Enable
Echo Off
® Echo On
Echo Complement

Transmit Result Receive OK, Echo Sent

Connected

Figure 3. General Tab
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MAX20340 Evaluation Kit Evaluates: MAX20340

Configure Tab
The Configure tab (Figure 4) configures the Master and Slave sides with more unique settings such as Transmit Filter,
Charge Timer, and LDO Voltage.

B Bi-directional Power Line Communication (MAX20340) EV Kit Tool - O =
File Device Options Help
Genefal | Configure | Communication Test | Register Map
Al
Master Slave faad
Device Enable Device Enable
@ ) Transmit Filter Enable @ Transmit Fitter Enable
Master/Slave Detection Reset Send Master/Slave Detection Reset Send
Transmit/Recene Reset Send Transmit/Receive Reset Send
Charge Timer Setting 120min v Minimum LOO Voltage asv v
LDO-BAT Difference 300mV i
Battery Recharge Threshold 36 -
Slave To ldle Command Send
MAX20340 EVIGE P2 (FW Ver, 0.5.1) Connected

Figure 4. Configure Tab
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MAX20340 Evaluation Kit

Communication Test Tab

The Communication Test tab (Figure 5) hosts the set-
tings for powerline communication tests. The user can
specify transmit data in hex values and run the test with
either single or continuous transmission. The Results
block, on the right side, shows all statistics, specifically
errors and error rate, when the test ends.

During a test, each transmission consists of three bytes. It
is not possible to send less than three bytes per transmis-
sion using the communication test tool.

Evaluates: MAX20340

To start a test, input the data to transmit in the Transmit
Data 0 to 2 text boxes or select Use Random Data to
use a pseudorandom set of three bytes. Clicking the
Transmit button transmits a single set of three bytes. To
start continuous transmission test, click Start Test button.
It is not possible to modify settings on other tabs while a
transmission is in progress.

Click Stop Test to end the communication test. A set of
Pause Test... buttons can be selected to stop the test
whenever a corresponding transmit or receive error is
detected. Click the Clear Results button any time to clear
the results.

@ Bi-directional Power Ling Communication (MAX20240) EV Kit Toal

File Device Options Help
General Cﬂﬂll;u.l.l‘e Commumnication Test REQI!IE{ Map
Cormmunication Test Configuration
Transmit Diata 0 000 |
Transmit Data 1 [ |
Transmit Data 2 000 i

Use Random Data

Transmit

Start Test Stop Test
Pause Test on Master Transmit Error
Pause Test on Slave Receve Emor

Pause Test on Slave Transmit Ermor

Pause Test on Master Receive Error

MAXI0340 EVKiE P2 (FW Ver. 0.5.1)

- m] *
|
Results Read Al
Communication Test Status: Not Running
Atternpted Transmissions 2080
Master Transmit Errors 1
Slave Receve Errors a1
Slave Transmit Errors 3
Master Receive Errors 76
Total Errors 1061
Total Error Rate 51.01%
Clear Results
Last Result: Transmitting” 0x00, 000, 000
MAST_TX_OK
SLAV RX_OK
SLAV_TX_OK
MAST_RX_OK
Connected .:

Figure 5. Communication Test Tab
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MAX20340 Evaluation Kit

Register Map Tab

The Register Map tab (Figure 6) provides all names and
values of MAX20340 registers. The user can click Read
All on the top right corner to perform a burst read of all
registers. Master and slave registers can be read and
written individually.

The left table shows the register to be read from or written
to. The right table contains descriptions for each register
field of the selected 8-bit register. All bits, along with their
field names, are displayed at the bottom of the page.

Evaluates: MAX20340

To set a bit, click the bit label. Bold text represents logic
1 and regular text represents logic 0. To configure the
changes to the device, click the Write button at the bot-
tom right.

When configuring PLC settings through the register map,
some settings, such as PLC Communication Frequency,
must be the same on the master and slave. To simplify
writing settings to both devices, toggle the Duplicate
Writes on Both Devices button. \When enabled, all writes
are committed to both the master and slave.

(@) Bi-directional Power Line Communication (MAX20340) EV Kit Togl - 0 x
File Device Options Help
General | Configure || Communication Test Register Map
* Master Registers Slave Registers Duplicate Writes on Both Devices seadll
Addr Register Value Field MHame Description
000 | DEWICE_ID Qo1 LDO Voltage Select (2 8V to 3.5V in 0.1V
ox01 | CONTROL1 OxED o steps). In slave mode, if D_LDO_BAT[2:0]
CONTROL2 et VLDO_MiN I= "000”, this se1s the minimum allowed
; : LDO voltage, overriding D_LDO_BAT[2:0]
Ll Rt Regulated LDO-BAT Difference. In slave
Qw04 | CONTROL4 Qw00 made, this sets the regulated difference
0x05 | DEV_STATUS1 oxsB between the voltages of LDO and BAT.
0406 | DEV_STATUS2 0x1D ? i %Uﬂc?mﬁj'pamd
0x07  DEV_STATUS_IRQ |0x00 Bit[4:2] |D_LDO_BAT 2 = 150mv
0x08 | DEV_STATUS_MASK 010 i 5 gggmﬁ
0x09 | PLC_COM_CTRL 0x94 5 = 300mV
OxDA  |PLC_STATUS | 0x00 6 = 350mV
OX0B  |PLC_IRQ 0xX00 T = 400mV
0OC  |PLC MASK oxoo PLC Masl.gr‘s RX wait timer after
il ransmission
0x0D | TX_DATAD w00 | Bit [1: TWAT TMR 0=2ms
OXOE | TX_DATA1 0x00 [0 - 1 - 1oms(Detaut)
[ = 100ms
OxOF | TX_DATA2 0x00 = AN
0x10  |RX_DATAD | 000
ouil | RX_DATA1 0x00
012 | RX_DATAZ 0x00 |
7 [ 5 4 3 2 1 0
V_LDO_MIN[Z] V_LDO_MIN[] V_LDO_MIN[D] ©_LDO_BAT[] O_LDO_BAT[] D_LDOBAT[D] TWAIT_TMR[]]  TWAT_TMR[D]
Mote: Click teat to set ar clear bit and “Write” to commit to device. Bold text is logic 1 Read Write
BI040 EVEGE P2 (FW Ver. 0.5.1) Connected

Figure 6. Register Map Tab
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MAX20340 Evaluation Kit

Detailed Description of Hardware

The MAX20340 EV kit evaluates the MAX20340 bidirec-
tional powerline communication management integrated
circuit, which communicates over the 12C interface. The
EV kit demonstrates the IC features such as different

Table 1. Jumper Table (JU1-JU26)

Evaluates: MAX20340

charging states, master/slave mode, 12C addresses, dual/
single PLC slave mode, and PLC slave addresses. The
EV kit uses the IC in a 9-bump (1.358mm x 1.358mm)
wafer-level package (WLP) on a proven, four-layer PCB
design. The EV kit operates from the USB +5V DC, and
therefore, does not require an external power supply.

JUMPER SHUNT POSITION DESCRIPTION
JUA 1.0+ Connect SDA of U2 to SDA of MAX32625PICO.
(Assuming a shunt is installed on JU12)
JU2 1.0+ Connect SCL of U2 to SCL of MAX32625PICO.
(Assuming a shunt is installed on JU13)
JU3 10 Connect SDA of U1 to SDA of MAX32625PICO.
(Assuming a shunt is installed on JU12)
JU4 1% Connec.t SCL of U1.to_ SCL of MAX32625PICO.
(Assuming a shunt is installed on JU13)
U5 1-2 Connect VCC2 of U2 to external power supply applied at VEXT.
2-3* Connect VCC2 of U2 to BBOUT of U6.
U6 Open* Disconnect VCC1 of U1 to CHGIN of U5.
Closed Connect VCC1 of U1 to CHGIN of U5.
JuT 1-2 Connect VBAT1 of U1 to external power supply applied at VEXT.
2-3 Connect VBAT1 of U1 to VBAT of U5.
m 1-2 Connect VBAT2 of U2 to external power supply applied at VEXT.
2-3* Connect VBAT2 of U2 to BBOUT of U6.
Ju9 1-2* Connect VIO to 3.3V of MAX32625PICO.
JU10 1-2* Connect INT2 of U2 to LED indicator.
JUM 1-2* Connect INT1 of U1 to LED indicator.
Ju12 1-2* Connect SDA line to MAX32625PICO.
JU13 1-2* Connect SCL line to MAX32625PICO.
Open Pull EN of U1 high to VIO to put it in low power shutdown state.
Ju14 1-2 Connect EN of U1 to GPIO of the MAX32625PICO.
2-3* Connect EN of U1 to ground to exit low power shutdown state.
Open Pull EN of U2 high to VIO to put it in low power shutdown state.
JU15 1-2 Connect EN of U2 to GPIO of the MAX32625PICO.
2-3* Connect EN of U2 to ground to exit low power shutdown state.
JU16 1-2* Connect PLC line between U1 and U2.
1-2* Select 19.1KQ resistor for RSEL of U1.
me 3-4 Select 24.9KQ resistor for RSEL of U1.
5-6 Select 31.6KQ resistor for RSEL of U1.
7-8 Select 43KQ resistor for RSEL of U1.

www.maximintegrated.com
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MAX20340 Evaluation Kit Evaluates: MAX20340

Table 1. Jumper Table (JU1-JU26) (continued)

JUMPER SHUNT POSITION DESCRIPTION
1-2 Select 3.9kQ resistor for RSEL of U2.
3-4 Select 6.65kQ resistor for RSEL of U2.
o1 5-6 Select 10.2kQ resistor for RSEL of U2.
7-8* Select 14.3kQ resistor for RSEL of U2.
JU1S 1-2*¢ Connect BBIN of U6 to external power supply applied at VEXT.
2-3 Connect BBIN of U6 to MAX32625PICO 5V.
Ju20 1-2 Connect FAST to CAP pin of U6.
JU21 122 Do not install a shunt on JU21. It is for connecting an optional external battery pack to the
MAX20335 battery charger.
Ju23 1-2* Connect VBUS of USB1 to external power supply applied at VEXT.
Ju24 1-2 Connect 2.2uF capacitor to CHGIN of U5.
1.0 Connect the fixed-value R8 to form the bottom resistor of the resistor divider between VBAT
of U5 and AIN2 of MAX32625PICO.
025 0.3 Connect the potentiometer to form the bottom resistor of the resistor divider between VBAT
of U5 and AIN2 of MAX32625PICO.
JU26 1-2 Connect output capacitor C1 to VCC1 of U1. Install this shunt if LDO of U1 is enabled.
*Default position.

Ordering Information

PART

TYPE

MAX20340EVKIT#

EV Kit

#Denotes RoHS compliance.

www.maximintegrated.com
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MAX20340 Evaluation Kit

MAX20340 EV Kit Bill of Materials

Evaluates: MAX20340

ITEM REF_DES DNI/DNP [ QTY MFG PART # MANUFACTURER VALUE DESCRIPTION
L |cnciocz, ] o |GRMLSSRE0I226MELL | MURATA 2UF CAPACITOR; SMT (0402); CERAMIC CHIP; 22UF; 6.3V;
16, C17 TOL=20%; TC=X5R ;
2 |c2ca,cs B 4 |0603ZC105KAT2A AVX 1UF CAP; SMT (0603); 1UF; 10%; 10V; X7R; CERAMIC CHIP
3 |cs - 1 |6TPE220MAZB PANASONIC 220UF CAP; SMT (CASE_B2); 220UF; 20%; 6.3V; TANTALUM CHIP
GRM21BRE1ALOBKELS; [ o o e
s les 20 ) , |Er-2rBra05; AMSUNG ELECTRONICS: 100F CAPACITOR; SMT (0805); CERAMIC CHIP; 10UF; 10V;
' CL21A106KPCLONG; VIURATA ’ TOL=10%; MODEL=; TG=-55 DEGC TO +85 DEGC; TC=X5R
GRM219R61A106KE44
s oo ) 1 |c1608xsrin10akosonn  |ToK 0AUF CAPACITOR; SMT (0603); CERAMIC CHIP; 0.1UF; 50V;
TOL=10%; MODEL=C SERIES; TG=-55 DEGC TO +85 DEGC; TC=X5R
o lcis ] 1 |oRmos3R61A105MELs  |MURATA 0 CAPACITOR; SMT (0201); CERAMIC CHIP; 1UF; 10V;
TOL=20%; TG=-55 DEGC TO +85 DEGC; TC=X5R
7 |c14, c15, c19 - 3 |C1005X5R1V225M050BC  [TDK 2.2UF CAPACITOR; SMT (0402); CERAMIC CHIP; 2.2UF; 35V;
TOL=20%; MODEL=C SERIES; TG=-55 DEGC TO +85 DEGC; TC=X5R
8 |ps1-Ds3 N 3 |LG L29K-G2J1-24 OSRAM LG L29K-G2J1-24 DIODE; LED; SMT (0603); Vf=1.7V; Ifitest)=0.002A;
-40 DEGC TO +100 DEGC
5 | ] R SAMTEC $50-102-02-T-5-RA | CONNECTOR; FEMALE; THROUGH HOLE; 0.025IN SQUARE POST
SOCKET; SSQ SERIES; RIGHT ANGLE; 2PINS
0 |2 ] 1 | 209960246 HARWIN V120.9960246 CONNECTOR; MALE; THROUGH HOLE; PIN HEADER ASSEMBLY;
M20 SERIES; RIGHT ANGLE; 2PINS
13, 1U1-JU4, JUS, . ] . ]
11 |1Ug-JU13, JU16, JU20, - 17 |PCCO25AAN SULLINS PCCO2SAAN :gso'\ﬁgf; m’;}z;giggig szsEb [;ZECAKAWAY' STRAIGHT
1U21, JU23, JU24, JU26 ’ i
15 |WUs,1U7,0U8,U14, ] 5 [pecossann SULLINS PECOISAAN CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT;
JU15, JU19, JU25 3PINS
13 |u17,1U18 - 2 |PEcoapaan SULLINS ELECTRONICS CORP. PECO4DAAN ;SIZSECTOR" MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT;
DFE252012F-1ROM=P2;
14 |1 - 1 520 OM=P2; | MURATA;MURATA 1UH INDUCTOR; SMT (1008); METAL; 1UH; 20%; 3.3A
DFE252012F-1ROM
N ] . 0032 | KEYSTONE 9032 | MACHINE FABRICATED; ROUND-THRU HOLE SPACER;
NO THREAD; M3.5; 5/8IN; NYLON
0400 o, - -
16 |R1,R2,R25 - 3 [crewo402499RFK VISHAY DALE 490|RESISTOR; 0402; 499 OHM; 1%; 100PPM; 0.0625W;
THICK FILM
7 s ] 1 |eraznces0z PANASONIC 2.0k RESISTOR; 0402; 3.9K OHM; 0.1%; 25PPM; 0.063W;
THICK FILM
15 |ra ] 1 |ersarkresst PANASONIC 6 65K RESISTOR; 0402; 6.65K OHM; 1%; 100PPM; 0.10W;
THICK FILM
19 |rs ] 1 |cRewoa0210K2FK; VISHAY DALEVENKEL LTD 102K RESISTOR; 0402; 10.2K OHM; 1%; 100PPM; 0.063W;
CR0402-16W-1022 THICK FILM
P
0 |re ] 1 |crowosoziakar VISHAY DALE 143K RESISTOR, 0402, 14.3K OHM, 1%, 100PPM, 0.0625W,
THICK FILM
5
1 | ] 1 |crowoso31msork VISHAY DALE L5 RESISTOR, 0603, 1.5M OHM, 1%, 100PPM, 0.10W,
THICK FILM
22 |Rs B 1 |ERI-PB6D4993 PANASONIC 499K RES; SMT (0805); 499K; 0.5%; +/-50PPM/DEGC; 0.25W
23 |ro, R34 ] 5 |5296v-1.50aLF BOURNS 500K RESISTOR; THROUGH-HOLE-RADIAL LEAD; 500K OHM;
10%; 100PPM; 0.5W; SQUARE TRIMMING POTENTIOMETER
n |ras ] 1 |cRO402-16W-1912FT; VENKEL LTD AVISHAY DALE 191K RESISTOR; 0402; 19.1K OHM; 1%; 100PPM; 0.063W;
CRCW040219K1FK THICK FILM
0400 o - -
5 |ris ] 1 |errarkr2292 PANASONIC 240K RESISTOR; 0402; 24.9K OHM; 1%; 100PPM; 0.10W;
THICK FILM
26 [R17 - 1 |cRCW040231K6FK VISHAY DALE 316K RESISTOR; 0402; 31.6K OHM; 1%; 100PPM; 0.063W;
THICK FILM
27 |R18 - 1 |cRCW040243K0FK VISHAY DALE 43k RESISTOR; 0402; 43K OHM; 1%; 100PPM; 0.063W;
THICK FILM
26 |Risroa ] ¢ |CROW04024K70FK; VISHAY DALE; a7k RESISTOR, 0402, 4.7K OHM, 1%, 100PPM, 0.0625W,
MCRO1MZPF4701 ROHM SEMICONDUCTOR ) THICK FILM
29 |R26,R31 - 2 |CRCWO40210KOPK; VISHAY DALE;YAGEO PHICOMP  |10K RESISTOR; 0402; 10K; 1%; 100PPM; 0.0625W; THICK FILM
RCO402FR-0710KL
ERA-3AEB104;
30 [R27 - 1 |ERA‘AEB1O0L PANASONIC;YAGEO 100K RESISTOR; 0603; 100K OHM; 0.1%; 25PPM; 0.1W; THIN FILM
AT0603BRDO7100KL
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MAX20340 Evaluation Kit Evaluates: MAX20340

MAX20340 EV Kit Bill of Materials (continued)

ITEM REF_DES DNI/DNP | QTY MFG PART # MANUFACTURER VALUE DESCRIPTION
RCO603FR-0710KL;

31 |R29, R30, R32, R33 - 4 YAGEO;YAGEO 10K RESISTOR; 0603; 10K OHM; 1%; 100PPM; 0.1W; THICK FILM
ACO603FR-0710KL
32 |R35 - 1 |RNCPO603FTD2K00 STACKPOLE ELECTRONICS INC. 2K RESISTOR; 0603; 2K OHM; 1%; 100PPM; 0.125W; THICK FILM
TEST POINT; JUMPER; STR; TOTAL LENGTH=0.24IN;
33 [SULSUIS, - 22 |S1100-B;SX1100-B; KYCON;KYCON; $X1100-B BLACK; INSULATION=PBT; PHOSPHOR BRONZE
SU23-5U25 STCO2SYAN SULLINS ELECTRONICS CORP.

CONTACT=GOLD PLATED
TEST POINT; PIN DIA=0.125IN; TOTAL LENGTH=0.445IN;

34 IE;TE;G - 7 5011|KEYSTONE N/A BOARD HOLE=0.063IN; BLACK; PHOSPHOR BRONZE
WIRE SILVER PLATE FINISH;
35 |tPa ) 1 5010 KEYSTONE N/A TEST POINT; PIN DIA=0.125IN; TOTAL LENGTH=0.445IN;

BOARD HOLE=0.063IN; RED; PHOSPHOR BRONZE WIRE SIL;
TEST POINT; PIN DIA=0.1IN; TOTAL LENGTH=0.3IN;

36 |TP5,TP10 - 2 5004 | KEYSTONE N/A BOARD HOLE=0.04IN; YELLOW; PHOSPHOR BRONZE
WIRE SILVER PLATE FINISH;

TEST POINT; PIN DIA=0.1IN; TOTAL LENGTH=0.3IN;

37 |TP6-TP9 - 4 5000|KEYSTONE N/A BOARD HOLE=0.04IN; RED; PHOSPHOR BRONZE

WIRE SILVER PLATE FINISH;

EVKIT PART - IC; MAX20340; BI-DIRECTIONAL POWER
LINE COMMUNICATION MANAGEMENT IC; WLP9;
PACKAGE OUTLINE DRAWING: 21-100389;

PACKAGE CODE: W91R1+1

MODULE; BOARD; MAX32625PICO BOARD DESIGN

39 (U3 - 1 |MAX32625PICO MAXIM MAX32625PICO FOR MAX32625 ARM CORTEX-M4F; BOARD;
LAMINATED PLASTIC WITH COPPER CLAD;

IC; BUF; TINY LOGIC ULTRA-HIGH SPEED DUAL BUFFER;
SC70-6

EVKIT PART - IC; PWRM; WEARABLE CHARGE
MANAGEMENT SOLUTION; WLP36;

EVKIT PART - IC; ULTRA-LOW QUIESCENT CURRENT;
42 U6 - 1 [MAX20343EEWE+ MAXIM MAX20343EEWE+ LOW NOISE 3.5W BUCKBOOST REGULATOR; WLP16;
PACKAGE OUTLINE: 21-100328; PACKAGE CODE: W161C2+1
CONNECTOR; FEMALE; SMT; MICRO USB B TYPE
RECEPTACLE; RIGHT ANGLE; 5PINS

44 |PCB - 1 [MAX20340 MAXIM PCB PCB:MAX20340

CONNECTOR; WIREMOUNT; CIRCUIT BOARD TEST
POINT MINIATURE PROBE; STRAIGHT; 4PINS

38 |[U1,U2 - 2 |MAX20340 MAXIM MAX20340

40 U4 N 1 [NC7WZ07P6X FAIRCHILD SEMICONDUCTOR NC7WZ07P6X

41 |U5 - 1 |MAX20335 MAXIM MAX20335

43 |USB1 - 1 ]10118192-0001LF FCI CONNECT 10118192-0001LF

45 |PS1-PS3 DNP 0 |[131-4353-00 TEKTRONICS 131-4353-00

TOTAL 127
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MAX20340 EV Kit PCB Layouts (continued)
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MAX20340 EV Kit PCB Layout—Internal 2
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MAX20340 EV Kit PCB Layouts (continued)
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